DNA Sequence Analysis Tutorial
Genetics Laboratory

By Jason Evans, Luke Sheneman and Celeste Brown

1 What is VectorNTI?

From the Informax website:

VectorNTI equips laboratories with an extensive range of software tools for sequence
analysis and molecule manipulation. Integration of data and analysis tools is
achieved using an intuitive, object-oriented database for the storage and organization
of DNA, protein and oligonucleotide sequences, and other molecular biology data.
From the Database Explorer, users can launch comprehensive, publication-quality
views of any sequence in an integrated, multi-pane Molecule Display window.

Within this window, make a selection of some sequence graphically--an Open
Reading Frame (ORF), for example--and apply all the tools necessary to design
multiple sets of PCR primers, initiate a BLAST search against any division of
GenBank, translate using any one of numerous genetic codes, or automatically design
a cloning strategy to create a new recombinant molecule. The VectorNTI Local
Database stores any new protein sequences generated, or PCR primers designed, and
keeps a record of the parent-descendant relationships that might exist between
molecules. These workflows can be performed without any reformatting of data,
allowing the researcher to concentrate on the science, rather than the technology,
underlying their bioinformatics analyses. Many additional bioinformatics workflows
are possible within Vector NTL.

% Molecular biology data management: storage of DNA/RNA Molecules, Protein
Molecules, Enzymes, Oligos, Gel Markers, Citations, BLAST Results and
Analysis Results

Creating, mapping, analyzing, annotating and illustrating DNA and protein
sequences

PCR, sequencing and hybridization primer/probe design

BLAST searching, viewing of results, and recovery of hits

Recombinant cloning strategy design

PubMed/Entrez searching, viewing and recovery of results

In silico gel electrophoresis

Connectivity to numerous Internet analysis tools

Primer Design

DNA Sequence Analysis

Protein Sequence Analysis

BLAST Searching

Database Explorer
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2 Goal

You were given the DNA for an organism, but all you know about the organism is that it is a
mammal, and you were asked to determine what species the sample came from. You have
amplified CytB and now have the sequence for the amplified product on both strands. You will
edit the sequence data to correct any ambiguities between the two sequences. You will use the
resulting sequence to search for organisms most similar to your mystery organism.

3 Getting Started

Log onto the computer using the name of the terminal (bottom left hand corner of the monitor) as
the login name, and the name of the terminal preceded by an exclamation point as the password:
USER name: sunray01 PASSWORD: !sunray01 (the password will not appear in the window).

Welcome to remote host celaeno

S Sun

Please enter your user hame *  microsystems

su
oK Start Over e Help SOLARIS"™S

Welcome sunrayO1 Y,
: i
Common Desktop Environment (CDE) \’C‘
Please enter your password SOLARIg

COMMON DESKTOP
oK Start Over Options - ‘\Help ENVIRONMENT

Be sure that the system is Common Desktop Environment by selecting Options: Session:
Common Desktop Environment. REMEMBER which computer you are working on so you
can find your results for the next computer lab.

Click on the Windows like icon (rdesktop) in the bottom left hand corner of the screen to access
the Windows 2000 computer. Use the same login and password.
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4 Using ContigExpress

We will use ContigExpress to create a contiguous DNA sequence from your raw chromatograph
data produced by the automated DNA sequencer. ContigExpress is a tool that allows you to
assemble DNA fragments, both text sequences and raw chromatograms directly from an
automated DNA sequencer, into overlapping sequences known as “contigs”. Users can create
ContigExpress projects and store sequences, contigs, and the options used when assembling the
contigs.

In order to create a contig from distinct DNA fragments, you will learn how to

* Create and manipulate a ContigExpress project

* Assemble contigs

e Edit a contig to remove ambiguities

* Export a contig as a single DNA sequence for further analysis

To start a new ContigExpress project, click on Start: Programs: Informax 2003: VectorNTI
Suite9: Contig Express:

reportgen

enomBench Utilities
Ltilites
3D Molecule Viewer
Align¥ Blocks
Align
Analysis Monitor

= Set Program Access and Defaults

BioAnnatator

WinZip BLAST Search
BLAST Viewer

Cikation Viewer

ContigExpress <—

GenomBench

Accessories
% Adobe
Dacuments 4 % Capture By George!
TS b % Genoma Client Tools
% Startup
Search 3 % Wirtual PC Additions
E Acrobat Reader 5.1 - Query Application
e e Internet Explorer Release Notes
(]

FpR|  Programs

License Agreement

License Manager

EAQ@sshalritusi

PubMed-Entrez Search

2000 Professional

Windows Media Player Remote Database Sources Wizard
% WinZip @ ‘Weckor NTI Explorer
MTI Suite @ * f' Yector NTI

@ Product Update

Run...

Shut Down...

Imstart re |
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The ContigExpress Project window will open. At this point, you need to get your sequencing
results. Click on My Computer and then click on the CD drive. Open the folder for your lab



section, and then open the folder with your group’s two abi files. Select the two files and drag
them to the Fragments(MAIN) folder in the ContigExpress Project window.

Once you drop the fragments into ContigExpress, you should get a message indicating that the
fragment importing was successful.

~ | [ =me
= % B
History Yiew

ﬂ Fragments (MAIN) Es Al 0aring
% 100% done

2 fragment(z] successfully imported
Job time:00:00:00

oK

0 fragments -]

&= ContigExpress Project - sUntitled *>

Project Edit View Assemble Align  Analyses Tools  Help

= E%EE = & = =EEEL =(iad

History Wiew 2 Fragment{s) in project
I Fragments {MAIN) Narme [
=
=
2 fragments selected =]

Once both of the sequence fragments have been imported into ContigExpress, select both of the
fragments inside of the ContigExpress project window. Select Assemble > Assemble Selected
Fragments from the ContigExpress pull-down menu. The program tells you how many contigs
were assembled and how long it took. Click on OK.

& ContigExpress Project - <Untitled *>
Project  Edit  View

S8 Align  Analyses Tools Help

History Yiew
Fragments (MAIN) &% ContigExpress - Assemble Selected Malecules

#7 ContigExpress - Open Mew Assembly Project
=[5}

Makes a new assembly from selected items (if any) EE




Assembling DNA fragments essentially performs an alignment of the overlapping region of the
two fragments. Your window should now look like this:

= ContigExpress Project - <Untitled *>

Project  Edit Wiew Assemble  Align  Analyses  Tools Help

SERE ST e x5 RNEEE EE S
|History Wigw |3 itemis) in 'Assembly 1'
@ Fragments {MAIN) Tarme |
Q Assembly 1 [ZContig 1
Yo
Yoz

1 conkig @ A

Contig 1 is now the only contig in Assembly 1. Rename the Assembly by clicking on “Assembly
1” and then waiting a second and clicking again. Change the name to reflect your Class Period
and Name (eg. TuAM_CBrown). Contig 1 is shown with two sub-fragments. You can rename
your Contigs and your individual fragments if you like.

Now double-click on your contig (i.e. “Contig 1) in order to edit it. A contig editor window
will open:

Contig  Edit Wiew Align Analyses Assemble Tools Window Help

| Bl Een o g QS K

aTE N H

Fa#

SVIERIESMZIEZZ

E3/Contig 1

% Contig 1 (2 fragments)
(] General Description

[ Fragments JKZ: 12 « §16 (complementary)

KA1 783

| B J00 5D BO0 6D BDD 360 4D 460 gO0 SAD GO BAD 70D 750 300

‘ i 10 z0 30 40 50 ) 70 80 an
@ K2 1 GMCCAMCATCCGTAARAACCHNCCCNCTCC TAARAATCRGAAACCAATCATTCATTGACTTACCAACNCCAACAAGCATTTCAGE
> i1 1ETCAGACTAATGACEA - CATCCGT - - AAACCACCCACTCCTAAAAATCGTAAACCAATCATTCATTGACTTACCAACACCAACAAGCATTTCAGE

Eontig1 I CTCAGACTAATGACCANCATCCGTAAAAAC CACCCACTCC TAARAATCGHARACCAATCATTCATTGAC T TACCAACACCAACAAGCATT TCAGE
.. -+ .. + .
| I

Pos; 0/0 =1




This window is broken up into three main panes. The upper left pane contains simple
information about the contig, a textual annotated description of the contig, and a description of
the fragments within the contig. The upper right pane presents a graphical representation of the
contig and the way in which the fragments overlap in the contig. Also shown in the lower
portion of this pane is the location of known discrepancies in the contig. These discrepancies
represent nucleotides that differ between the two sequences, and will need to be resolved. The
lower pane depicts the actual sequences themselves and depicts the fundamental details of the
contig, showing the exact way in which the contig was constructed from the sequence fragments.
Ambiguities and gaps are presented here in detail, and can be resolved manually in this lower
pane.

The next step is to manually resolve all discrepancies in the contig. Prior to doing this, it is best
to show the detailed chromatogram output from the automated sequencer. This can be done by
right-clicking anywhere in the lower pane and selecting Show All Chromatograms from the
pop-up window.

i ContigExpress - Contig 1™

Contig  Edit View Align  Analyses  Assemble  Tools Window Help
| @l oo | @ RSN
ki === R R
2 Contig O

[#] Conlig 1 [2 ragments)

B¢ General Description
Contig 1 JKZ: 12 « 816 (complementary)
Creation Date: 11:01 P Julp 13, 2003 |
Last Modification Date: 17:01 P Julp 13, 2003

Belongs ta Assembly: Assembly 1

Nurber of fragments: 2 K11 s 783
Consers Lt £ —
‘-3 Fragments
JE2:12 « 816 [complementary) | fo Joo Jeb F00 pe0 GO0 @0 00 j60 pO0 p0 fO0 PSO FOO 760 30
[k 10 20 30 a0 50 €0 70 50 30
« JEZ 1 GMNCCAMCATCCGTAAAAACCNCCCNCTCC TAAAAATCGGAAACCAATCATTCATTGACTTACCAACNCCAACAAGCATTTCAGC

CTCAGACTAATGACCA - CATCCGT - - AAACCACCCACTCC TAAAAATCGTAAACCAATCATTCATTGACTTACCAACACCAACAAGCATTTCAGE

Open Fragment
T Moye Fragment...

Copy Chrl+C
&3 Camera...

Contig 1 NETCAGACTAATGACCANCATCCGTAAAAACCACCCACTCOTARAA Select Al CTTACCAACACCAACAAGCATTTCAGC
. . 4+ . .

|+ e Reverse Complement Fragment _»I
Show all chromatograms Reverse Complement Assembly @ P

Lde chaw chramatogram for K1

Show All Chromatagrams

Hide all Chromatograms

Consensus Translation 4

Jj_ Print Preview



Once you have selected Show All Chromatograms, your ContigExpress window looks like this:

- [B]x]
e
a o M s e

[f] Contig 1 (2 fragments]
=3 General Description

Contig 1 JK2: 12 & 816 (complemertary)
Creation Date: 11:01 PM July 13, 2003

Last Madification Date: 11:01 PM July 13, 2003
Belongs to Assembly: Aszembly 1
Mumber of fragments: 2
Conzensus Length: 816
(=144 Fragments

JK1 1783

K212 & 816 [complementsry] ) B0 o0 iS00 2D AD0 350 DD 60 SO0 SED BOD psn 700 ysnaqn

252[}5TCC."-\T."-\TCGGCCGRGGCTTGTP«CTF\CGGETEP\TF\CF\CETTCCTP\

ccT1TCGCATATCGGCCGEGAGGCTTGETALCTACGGLC TCATALCALCDCTTCGCT A

93c c T CcCcAaTATCGGEGCCGAGGOCTTGETACTALCGGCLCTCATALCALCC T TCOCT A
I TN N | O [V LV NN Y DY VL Y (T P
Comtig1[283c c Tcca T A TCGGCOCGCGAG G GTITGITALGTALGGIG GG GTGATALGATLCTELTTITGEG A
L l |

Pos: 30/27

In order to manually remove all ambiguities from this fragment assembly, you will:

% Locate all ambiguity codes (depicted in red in the consensus sequence at the bottom of
the lower pane, as a symbol underneath the consensus sequence and as green vertical
lines in the graphics pane) and resolve the ambiguity character with the most likely
alternative. In most cases, the most appropriate solution is simply to choose the
unambiguous code from the other sequenced fragment in the same aligned column
(where it overlaps).

Locate and remove all gaps. In some cases, the solution here is to remove the entire
column, while sometimes the solution is to change the gap code in one of the fragments
to the most obvious alternative character. Use the chromatogram as your guide. Also,
choose the better chromatogram. In the picture above, the top chromatogram is good and
the lower chromatogram is very poor.

X/
°

_Action How to Perform Sequence Pane Result _ Chromatogram Pane Result

Delete | Select residues; ({) replaces NTs; Nts (- - - -) appear in upper sequence

press Delete moved below strand
Insert | Place caret; type | (1) appears below new A break appears in the

new Nts NTs; new NTs are colored | chromatogram

Select NTs; type | New NTs appear in strand; | New NTs appear in upper
Replace | new Nts replaced NTs moved below | sequence; no break in

strand chromatogram

Finally, you should delete the consensus sequence where there is only sequence in one direction.




5 Saving the Contig as a full, standalone DNA sequence

Once all ambiguities are resolved, select (highlight) the entire consensus sequence. The easiest
way to do this is to right click on Contigl in the bottom pane and select Select All. Right click
on the consensus sequence and select Copy sequence from 1 bp to n bp

£3 Contig 1 * |:”E|El

14 Contig 1 [2 fragments)

[_1 General Description

[Z] Fragments

JKZ 12 & 515 (complementary)

770 780 790 800 810
«JF2[78Cc A G AC A ACTALCACCCECAG CAAAACTLCCALCTGASAELCATLCTCLCACLCTLCTLCCAATAATCTEC

[\/\Ar\/\{\aom/&\

C AGACAARLCTATRLC ATLCTLCTEGCIEC A
»JE1|7E86lC & 8 A C A ACTACLCACCTCE A

G CAANMNCCCALCTGAALCALCTCCATCLCCLCTCTCAATAATLCTLC

Contig 1

Select all

Reverse Complement Assembly

Show Al Chromatograms

Hide all Chromatograms

Consensus Translation

B, Brint Preview

At this point, the consensus sequence representing the assembled contig of the two DNA
fragments is in your cut/paste buffer. Open the main Vector NTI window Start: Programs:
Informax 2003: VectorNTI Suite 9: VectorNTI. Seclect File > Create New Sequence -
Using Sequence Editor (DNA/RNA)



£" Vector NTI
GEEEEEN Edit View Analyses Gel List Align Assemble  Tools  Window  Help

ﬂ@m\ IUsing Sequence Editar (DMa/RMAY. .. Eo % | = | v | ‘ th
= Cpen... Chl+0 Using Sequence Editor (Protein). .. g ’ — @ EL @ @ [:&

|Jsing Construck/Design Procedure (DNASRMAY. ..

Open Shorteut, .,

Page Setup...
Prink Setup...

Exit

A dialog pops up which allows you to annotate, name, and edit the characteristics of the new
molecule:

@ ————————— —
New DNA/RNA Molecule (%]
User Fields I Comments I Kepwords I
General | DMA/RMNA Molecule I Sequence and Maps

[MEwmOL J

Type: DMARMNA Maleculz

Record #: 0

Status: Local [created or modified by current uzer)

Originally Created by: - Luke Sheneman Abaout.. |
Creation date: 71472003 12:16:05 AM

Last Modification by Luke Sheneman &bout._. |
Modification date: Unknawn

Ok Cancel I Apply | Help |

In the General tab, give the new molecule a name that reflects your lab Day and Time and your
Name (Tu_ AM_CBrown). Next, click on the DNA/RNA Molecule tab and make sure that the
DNA is marked as linear and that the molecule is treated as DNA rather than RNA.



New DNA/RNA Molecule [%]
Uzer Fields | Comments | Kewmards |
General DMNARNA Molecule | Sequence and Maps

¢ Circular & DN
@ Linear " RMA

— Entra-Chromozome Replication
[~ Bacteria [~ Yeast [ Animal/Other Eukaryotic

—Replicon Type
™ Plasmid I~ Phagemid
[~ Cosmid I Wirus
[ Phage [~ Chromosome

Description:

ak. | Cancel |

Apply |

Help

Next, click on the Sequence and Maps tab in this dialog, and then click on the Edit Sequence

button in this dialog.

Mew DNA/RNA Molecule (%]
Uszer Fields | Commerits I Kepwords |
Gereral | DRA/RHA Molecule Sequence and Maps
Sequence length: 0 bp Edit Sequence... [: |
— Feature Map
Add... |
Edit... |
Delete |
— Restriction Map
Add...
Edi... |
Delete |
ak | Cancel | Apply | Help |

A dialog box will open allowing you to enter the complete DNA sequence of the consensus
contig. Paste the consensus contig sequence into this window by clicking on the Paste button,
and then pressing OK and then OK again.
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M eotide Sequence o ONnse ﬂ

Paste Find... Ok hJ Cancel |
1

101 AMACTTCGGT TCATTGCTGE GCATCTGCCT AGCAATGCAA ATTCTTACAG 4
151 GUTTATTCCT AGCAATACAC TATACATCAG ACACCATAAC AGCCTTCTCA
201  TCTGTAACTC ACATCTGCCG AGACGTAAAC TATGGCTGAT TAATTCGTTA

251 CCTACATGCC AACGGCGCAT CCCTATTCTT CATATGCCTA TACCTCCATA
301 TCGGCCGAGE CTTGTACTAC GGUTCATACA CCTTCCTAGA AACTTGAAAC
351  ATCGGAATTA TCCTATTATT CACCGTTATA GCCACAGCAT TTATAGGTTA
401  TGTCCTACCA TGAGGACAAL TATCATTCTG AGGGGCCACA GTAATTACCA
451  ACCTATTATC TGCCATCCCC TACATTGGAA CCGACCTAGT AGAATGAATC

501 TGAGGTGGCT TCTCAGTAGA CAAAGCAACT CTAACACGCT TCTTCGCCTT
551 CCACTTCATC TTACCATTTA TTATCACAGC ACTCGTAGTA GTCCACCTGT
601  TATTCCTACAE CGAAACAGGA TCAAACAACC CCACAGGTAT CTCGTCRAAC
651 ATAGACACAA TCCCATTCCA CCCGTACTAT ACAATTAAMG ATATCCTAGG
701 CTTAATTCTC ATAATCCTGC TTCTAATAAC ATTAGTTCTA TTTTACCCAG

751  ACCTACTAGG AGACCCAGAC AACTACACCC CAGCAACCCA CTGAACACTC
801 CACCCCAATA ACC

=

| inserted 813, deleted 813 |[aters1zbp || |

You should now have a linear DNA sequence that represents the fully assembled and cleaned-up
DNA sequence which was output from the automated DNA sequencer. Your next job is to
identify the species from which this DNA sample originated.

Open your new DNA sequence by double-clicking on its name inside of your main Vector NTI
window. The Molecule viewer will pop up with your sequence inside:

oni B[]

[_i{a consensus1

1 General Description
[ ] Standard Fields

# Comments

[ '] Annotations consensusl
[0 Feature Map S1gbp

[Z1 Restriction/Methylation Map

1 TCAGACTAL TGACCACATC CGTAAARACC ACCCACTCCT AALAATCGTA AACCAATCAT TCATTGACTT ACCAACACCA ACAAGCATTT
AGTCTGATT ACTGGTGTAG GCATTTTTGG TGGGTGAGGL TTTTTAGCAT TTGGTTAGTA AGTAACTGAL TGGTTGTGGT TGTTCGTALL
101  ARACTTCGGT TCATTGCTGG GCATCTGCCT AGCAATGCAA ATTCTTACAG GCTTATTCCT AGCRATACAC TATACATCAG ACACCATRAC
TTTGRAGCCAE AGTAACGACC CGTAGACGGL TCGTTACGTT TAAGAATGTC CGAATAAGGA TCGTTATGTG ATATGTAGTC TGTGGTATTG
201 TCTGTAACTC ACATCTGCCG AGLCGTAAAC TATGGCTGAT TAATTCGTTA CCTACATGCC AACGGCGCAT CCCTATTCTT CATATGCCTA
AGACATTGLG TGTAGACG'%C TCTGCATTTG ATACCGACTAL ATTALGCLAT GGATGTACGG TTGCCGCGTL GGGATALAGRL GTATACGGAT
301 TCGGCCGAGG CTTGTACTHC GGCTCATACA CCTTCCTAGA AACTTGAAAC ATCGGAATTA TCCTATTATT CACCGTTATA GCCACAGCAT
AGCCGECTCC GRACATGATS CCGAGTATGT GGAAGGATCT TTGAACTTTG TAGCCTTAAT AGGATAATAL GTGGCAATAT CGGTGTCGTL

401 TOETOCTACCA TGAGGACALE TATCATTOTG AGGGGOCACA GTARTTACCE ACCTATTATC TGOCATOOOC TACATTGGRE COGACCTAGT %
| >

3

=

6 Translation into all 6 reading frames i
New Delete Fieset

L

At this point, we want to translate the DNA into protein. i | e |
Since we don’t know the proper reading frame for this R i
translation, we need to perform a translation for all 6 reading ﬁﬁ
frames. The sequences that you are working with are et | |
encoded on the mitochondrial DNA, and mtDNA uses a ooy | e
genetic code that is different from the Standard genetic code. %'%‘
In order for your translations to be accurate you will change EIEI
to the vertebrate mtDNA genetic code. Select Analyses = [t vy |
Translation = Set Genetic Code. And then change from —

Standard to Vertebrate Mitochondrial in the pull down menu.

Cancel

11



Click OK and when the Code window closes, select the entire nucleotide sequence by clicking in
the sequence pane and then going to Edit = Select all. Now you can translate the sequence:
Analyses = Translation = Into New Protein = 6 Frame Translation

0 0 B Ll
@ Malecule  Edit  Wiew Gel List Align Assemble Tools Window Help - O %
|2@@a T CHFYH B BRB | V PQ N
Active Pane: 4 Motifs... Frogs, A ‘ %= .5

B 1A consensus]
1 General Descripti
] Standard Fields

ORE... I
Mutagenesis 4 |
Set Genetic Code.., ) Aeal 402)

Direct Strand. ..

Restriction Analyses P

L
~ “ | In Sequence Pane  * Complementary Strand...
1 [ Annotations & Back Translation - -
6 Frame Translation -=|‘}=-
[ 1 Feature Map BioAnnotator 3

L. Feature...
[Z1 Restriction/Methy GenomBench Tools 4

AL Run Analysis Monitor
Web Analyses 3

€03 with splicing

b
Translate into new Proteins using & frame translation 1 bp - 509 bp (809 bp) | end (3 ‘ AI

A pop-up dialog will appear, asking which frames need to be translated. Just press Translate to
get all 6 possible reading frames.

Set Translation Frame(s)

Find Translation Frame(s] for
Specified Amino Acid String:

¥ 41 1 Find Flame[s]l

v +2 v 2
v +3 ]

Tranzlation Frames

Tranzlate | Cancel |

After pressing Translate, the following dialog will appear:

12



General l Frotein ] User Fields ] Comments ] Keywords ]
|Translati0n of conzensug] [direct 1) J
Tupe: Protein Molecule
Record #: 0
Status: Local [created or modified by curent user)
Originally Created by: - Luke Shenemar About...
Creation date: 7A14/200312:47: 49 PM
Last Modification by Luke Sheneman About..
Modification date: Unknown
QK | Cancel | | Help |

Change the name of the molecule to reflect your class period and name but keep the strand
designation (direct 1), then press OK. One of these dialogs will appear for each of the 6
translated proteins; change the names accordingly for each of them.

At this point, you have added 6 new protein sequences to your protein database. In order to see
all of the files, go to Window > Cascade and all 7 sequences will be visible.

7 ldentify Correct Reading Frame

The goal here is to identify the most likely reading frame, under the assumption that there are no
major sequencing errors. Only one of these proteins was correctly translated, since only one of
them could be in the correct reading frame during translation.

Look through all six translated proteins and identify the correct translation/reading frame.
Identifying the most likely protein is relatively simple. Look for a protein sequence with the
longest contiguous section of amino acid residues which lack stop codons. Stop codons are
represented with asterisk character. For example, the following sequence was not likely
translated in the correct reading frame, because it is sprinkled with asterisks and has no long
sections without stop codons:

<

MTHIRESHPL

TENPDNYTFL NPLSTFFHI

13



8 Blasting proteins against SwissProt

Once you have identified the best possible protein sequence, highlight the largest section of the
sequence between stop codons (as shown below), and perform a BLAST search against the
SwissProt database using this selected subsequence. Here, you will identify the sequence in the
SwissProt database with the most similarity to your sequence.

< | 2=
1 **PTFENHTH *SKFLHDSFI DLPTETHNISS
51
101
151
z01
251

FPSHTLHIERH
TWHMLLELLLI

* FPRPFIFPFHFNF TPFTDLILFRH
N APHPT

Perform the BLAST search by selecting Tools > BLAST Search, and then performing the
search against the selected portion of the sequence:

| Sequence Data

)
Range
" ‘whaole Sequence L I
{* Selection Only % |

BLAST Search (%]

Choose BLAST zerver

{» MCBI BLAST Server [Former 3-BLAST and Web-BLAST)
" Other [zpecify URL or Datazource]

| I~

Make sure that you are searching using the blastp program, and that you are searching against the
swissprot database and then press the Submit button:

41 Translation of consensus1 {complementary 1) - BLAST Search (NCBI OBlast server)

D B’ ﬁ [%? |BLAST 20 j Program: |b|aslp j Database: |swissprot j ﬁsuhm\th

Sequence | Parameters | PSI, PHI | MEGABLAST |

Source: Tranzlation of conzensuz] [complementany 1]
1 HNFGILLGACL IIQILTGLFP ZHTLHIRHAN RILFSSPHLP RROLWLNH3IL PPCORSIMNIL PMILRPHUTW NLLELLLIFE NLEHUMHPTT HNYSHRFHRI
101 ERPFNGTDIIL RGHCNHOF3II GHPLHERHRP3 EM3LEWILSER OQ3YPHPIFRW TLHPTFCEWE F33RP3FIFS RDRICOPHRF NLEFRONSIS SILLNORFPER
201 PIPPHPNPTP TDLILPRHVE RTQTTTHFQI H

The status column tells you what the program is doing. After awhile, the BLAST search will
conclude. Double-click on the name of the sequence to review the results of the BLAST search:

14



D 6 LT @: k’? |ELAST20 j Program: | blastp j Database: |swissprot

Sequence | Parameters | P35I, PHI | MEGABLAST |

Source: Translation of consensus [direct 3] [1-269)

1  CGVGCLVDLE VCSCLGSPNM SGENKVSRSE IRMRRMRPRR ILIEYGNGIL SEIEIRPVGL LDPVIRNERW TATRAVITEG RVEC
101  QTHITRIVPM GMADRRLVIT VAPCNDICPH GRTYPMEAVL ITV3SRMIPM FOVIEYEEFI PRPMWARHRE NIDAFLAWRRE MIQP
201 SDVCHMARKSC ENLNDACPEA EWSSDVCWIW CVDEGVIQEF LVGVIFECUS L

LY S Mame ‘ Skatus Request ID Hit count | Dake & Time | Server
| Translation of consensus1 (...  Finished 105621 2338-021655- 10499 500 Z003/07/14 12:26:41  MWCEI Q-Blask Server
Finished 1058214580-26159-24622 500 2003/07/14 13:00:43  MCEI

Blast Server

ranslation of consensus1

To see the hits from the BLAST search, expand the hits folder in the leftmost pane in the BLAST
Results Viewer window:

=
Paalks qn
Active pane: % i S, oS
[ [&] Translation of 1 (compl y 3)
=[#] Translation of 1 | I 30 in] Hit Distribution
Length: 251

1 Search parameters
2 & Hits: 500 molecules _|[

=[2] gil3t%802971spIQITF27ICYB_CYNGU (1 element) i 40 an 120 180 200 240

gl30580297 0l STF27ICYE CYHGL il | 2]
Protein: Cytochrome b 01}

=y
Length: 373 5|
(C15core: 95 (Bits:  41.2). Expectation: D.002 ||
=[] gil303158791splQSTF20ICYB_SPEWA (1 element)

(£

ail3031 687 Alspl STF20[CYE SPEWA
Prateir: Cytachrome b
Length: 379 H: 1}
(1 Score: 99 [Bits:  41.2), Expectation: 0.002
=[] 0il204554681splD33500ICYB_HIPAM (2 elements)
i|20455468)s010 33500ICYE HIPAM
Protein: Cytachrome b
Length: 373
(C1 Score: 95 [Bits:  41_2). Expectation: D.002
(1 Score: 65 (Bits: 29.6), Expectation: 5.9
=[] gil31219651spIP92487ICYB_EQUAS (2 elements]
il 21965]sp|PI2487|CYE EQUAS
Protein: Cytochrome b
Lenath: 373
Consensus FDNYTPANPLSTFPHI
Query sequence | 235 NEDINY TP ANPLSTPPHI
qil305802971:plG9TF2 | 252) DPDMNY TP ANFLSTPPHI

¥

1379

qi| 30560297 |sp| QATF27|CYB_CYMGL; Score: 95 (Bits:  41.2), Expectation: 0.0 E‘ﬂ

A set of scored results are shown in the upper-left window pane in the BLAST Results Viewer
window. Click once on the blue, underlined link of the “Hit”. Doing this downloads the
annotated SwissProt file for the molecule and displays it in the molecule viewer:
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Prote 0 & bi:prote 8 4
B 1A 033401 -~

"1 General Description MTCYB

(1 Standard Fields WMTCYE MTCYB MTCYEB MTCYB MTCYE

[ References

[ [] Annotations ¢

(] Analysis |

) Comments

[ Feature Map v
. | &

1 ?[‘ITNIRKSHPL IKILNNSFID LPTPVNISST WNFGSLLGAC LIIQILTGLF
51 LAMHEYTSDTL TAFSSVTHIC RDVNYGWIIR YLHANGASMF FLCLYAHIGR
101  GIYYGSYLYP ETWNIGIVLL LTVMATAFMG VVLPWGOMSF WGATVITNLL
151 SAIPYIGTHL VEWVUGGFSV DEATLTRFFA LHFILPFIVT ALVMVHLLFL
201 HETGSMNPTG LISDSDKIPF HPYY3VKDLL GLFLLILVLL LLTLFSFPDML
251 GDPDMYTPAM PLNTPPHIKP EVYFLFRYAT LRSTIPNELGG VLALVLSILI
301 LALLPLLETS EQRSLSFRPL SQCLFUILWVA DLITLTVUIGG QPWEHPYIIT
351 GQLASILYFS IILIFMPIAG LIENHLLET

Open the Standard Fields folder and discover what species is the closest to your sample.

9 Saving your results

If your first hit was not a cytochrome B sequence, you have chosen the wrong reading frame. Try
again until you find the correct reading frame. Once you are satisfied that you have the closest
sequence to yours, save this sequence by selecting File = Save As then select the Save in
Proteins Database As tab. Change the name of this protein to reflect your class period and
name.

Save As [ 7]

Save Az File  Save in Proteing Database Az | Remate Sources |

Seveine [[B] Protein Moecules MAN] -]

Hama | Lenath [ Modified [ Storage "~

[ 10RO VIBLIN 75 TD/B/s 122900 Basie [
E %HSE_CUEMA P VYR P Y

SR TETHRUMEN 3T TO/BAE T229PM Basic

1755 BEREX 145 10/08/031229PM_Basic

241 HOMAN 831 /MBI TZ2PM  Basic

5]41BB_HUMAN 255 /R T229PM Basic

[cil41BB_MOUISE 256 10/0BAI3 12:29PM—Basic

i 472 FUMAN 23 10/ 1229PM Basic

Similarly, save your Blast Results in the Database BLAST Results giving this file a name that
reflects your class period and name. When you close Contig Express, it will ask if you wish to
save your contigs, say yes, and save with a name that reflects your class period and name.

Log off of Windows using Start: Shut Down. When Windows has closed, click on the Exit

button at the center bottom of the screen and click on Log Out. Remember what computer you
were working on!!!!!!
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